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Summary

Waterhammer in piping systems results in unbalanced forces, particularly between changes in direction
such as elbow pairs, and changes in area such as valves, reducers and other inline components. It is not
uncommon for these forces to cause damage when a system is not properly designed to accommodate
them, resulting in failed restraints, overloaded equipment, large displacements and overstressing or even
failure, of pipe and fittings as illustrated in these photographs.

Unsupported pipe fails from transient
pressure plus the bending caused by
initial failure at reducer.

In some cases, hand calculations and conservative assumptions can be used to predict the magnitude,
direction, location and timing of these dynamic loads. In many cases however, the complexity of
waterhammer loading renders manual methods useless, requiring computer analysis to properly predict
the loading seen by a piping system.

Once these loads are determined, pipe stress software can be used to evaluate the piping system
response, such as deflections, restraint loads, equipment loads and stresses.

This paper examines a waterhammer event caused by the partial closing of a valve in a relatively simple
system. The hydraulic transient analysis is performed using AFT Impulse™, and the mechanical system
response is then evaluated using Intergraph’s CAESAR Il ® pipe stress analysis software.

One direct benefit of using these two particular applications is that AFT Impulse creates force-time data
files for direct import into CAESAR 11.



For those who use both of these applications, this paper will also help show you how to create,
transfer and apply waterhammer force-time data using these two software applications.

Nomenclature Subscripts

A =Area 1  =location 1
F  =Force 2 =location 2
m = momentum I = imbalanced
P =Pressure X = x direction
V = Velocity y =y direction

dP  =change in pressure
c = speed of sound (wave speed, celerity)
dV = change in velocity

Introduction

Waterhammer is a transient phenomenon that occurs in a liquid piping system when some event causes a
departure from steady state. When a transient is initiated, a single or series of coupled pressure/velocity
waves are generated and travel at close to the speed of sound through the piping system.

Events that cause waterhammer include:
o Valve closure or opening (in full or in part),
e Pump speed change (trip or startup)
e Relief valve cracking open
e Rapid tank pressurization

e Periodic pressure or flow conditions

Typically an engineer’s primary interest is transient peak pressures that result from
waterhammer, allowing proper selection of pipe strength and design for equipment protection and
general safety.

Discussion of Force Balance

Once the analyst ensures that peak-pressure limits are not exceeded during a transient event, attention is
typically turned to transient forces and how the system will respond to these forces.

Traditional Force Calculations (i.e. manual calculations) consider the loads caused by a sudden
change in pressure, and follow this pressure change as it moves through the pipe from its source to a
termination point at roughly the speed of sound. Between elbows, there is a static pressure force that is
exerted on each elbow along the axis of the pipe, equal to the pressure multiplied by the inside area of




the pipe. During the short duration where one elbow sees the elevated pressure while the next one does
not, there is a net-differential force acting on the elbow pair that can be quite significant. Once the
elevated pressure reaches the next elbow, the pressures equalize and the differential load between the
elbows disappears.

Figure 1 illustrates this force imbalance where the flow has been stopped downstream and the transient
pressure wave is traveling opposite to the original flow direction. For some finite duration of time, the
pressure is higher at node 2 than node 1, causing a net unbalanced pressure force in the direction of the
original flow.
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Figure 1. Force imbalance at an elbow pair using the traditional method of pressure difference

Based on Figure 1 the traditional force imbalance calculation is:
Pl,xAi,x + Pz,xAz,x = Fl,x (1)

Assuming that your hand-calculated pressure rise is reasonably accurate, this method is reliable for
simple systems such as in Figure 1, but the introduction of in-line components adds a level of
complexity that quickly renders these calculations useless. For example, if we introduce a valve in the
line and partially close it, some difficulties arise for the manual calculation method.
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Figure 2. Pressure force balance with in-line component



The traditional hand-calculation in this scenario would be an attempt to sum all of the pressure forces
acting at both elbows and both sides of the partially closed valve. With a partial valve closure, what are
the magnitudes of the transient pressures? What pressure loads are acting on each side of the valve? As
each pressure wave travels up and reflects back down each leg, how do these loads match up over time
at the elbows and at each side of the valve? With these complexities, the accuracy of our manual
calculation becomes highly suspect.

The ability to perform a comprehensive, computer-based hydraulic transient analysis allows us to
consider all of the loads occurring in the line: pressure forces, hydraulic forces at components, friction
and momentum, as they all change over time, and achieve an accurate representation of the transient
event and resulting loading.

Enhanced Force Calculations consider all hydraulic loading.
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Figure 3. Force balance between elbow pairs using an enhanced method

Based on Figure 3, the enhanced force balance calculation is:

Pl,xAl,x - ml,xvl,x + P2,xA2,x - mZ,XVZ,x + Z I:x,friction = I:I,>< (2)

Example AFT Impulse Model

Figure 4 shows the model used for this example. The total pipe length of 1080 feet is 20” diameter,
standard wall thickness, flowing water at 60 F. The transient event is the partial closure of valve J5,
from 100% flow to 10% flow over 2 seconds, with a Cv profile as shown in Figure 5.
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Figure 4. AFT Impulse model of system with a valve transient

AFT Impulse does not work on the basis of a three-dimensional interface because that is an unnecessary
complication when performing flow analysis. Instead, a two-dimensional diagramming approach with
component elevation is employed. The model shown in Figure 4 has the appearance of an isometric
view because creative use was made of AFT Impulse drawing features.

A Few Calculations

When a valve fully closes quickly, the magnitude of the resulting pressure rise in a liquid can be
conservatively estimated using the equation:

dP =p c AV (fluid density, speed of sound, change in velocity)

With our valve closing 90%, one might presume we could guess at the pressure rise using 90% of the

(p ¢ AV) magnitude. It turns out that this is incorrect by an order of magnitude. (How do we figure that
out? In this case, through analysis using AFT Impulse.) Without a good ball-park pressure-rise value,
our manual method is already in trouble. How do we apply this pressure to the partially closed valve
area? More uncertainty. It’s at this point that, even if we want to do a manual PA calculation, we’ll
need to rely on a computer-based transient hydraulic analysis to get the pressure data.
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Figure 5. Valve Transient: Cv vs. time. 100% flow to 10% flow in 2.
AFT Impulse Model Results

Traditional Approach

In reference to Figure 3, when calculating loads by hand, the stress analyst would typically attempt to
sum the Pressure x Area (PA) forces acting on both elbows and both sides of the valve. As mentioned
earlier, with a partial valve closure, predicting the pressure rise by hand is problematic, and the PA loads
on the valve are difficult to determine. To get useful values, one would run a transient hydraulic
analysis. This begs the question: “if you need to do a transient analysis to get the pressure rise and valve
loading in order to get a meaningful hand-calculation, why not just get the software to do the entire
task?”.

For simplicity, one might consider neglecting the loading at the valve and just hand-calculate the forces
between the elbows. We’ll demonstrate the flaw in this assumption by comparing the force-time data
that results from first neglecting, then including the loads acting on the partially-closed valve in the leg
of pipe between the elbows on either side of it.

Figure 6 shows the PA force differential between the second elbow pair (from Figure 4), neglecting all
other loading in this leg.
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Figure 6. Imbalanced forces between second elbow pair neglecting friction & loads on the valve

One observation that can be made from Figure 6 is that neglecting friction and momentum loads results
in non-zero steady-state loading. At time zero, before any transient has occurred, the force imbalance is
about -1300 Ibf. After 2 seconds, the force imbalance oscillates and with additional time will eventually
decay to a final steady-state value of about -4400 Ibf. However, the time zero and final steady-state
imbalanced forces should be zero because there are no force imbalances across this elbow pair under
steady-state conditions.

This is something that we neglect in our hand-calculations for three reasons: 1) it is the sudden changing
of the load that causes our dynamic response, so we can neglect the steady-state loads without
influencing the dynamic analysis of the event, 2) the magnitude of the steady-state friction loads are
relatively small, and 3) we don’t want to spend the time required to hand-calculate the exact answer.

That said, it is nonetheless analytically pleasing to properly include and consider all loads, steady-state
or transient, and obtain a full, true picture of the physical event.

It needs to be understood that, in the AFT Impulse software, there is an option where you choose
whether to “include friction and momentum” between two points, which actually means:
“including all hydraulic losses and PA differences”, not just pipe-wall friction and momentum.
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This has a very helpful implication. All loads on pipe & inline components between two points on one
axis will be properly considered by simply identifying the two points, and turning on the momentum &
friction settings. There is no need therefore, to identify all of the intermediate points, such as each side
of a valve, filter, reducers, or other inline components and sum up the loads; this is done automatically,
which makes the task of defining the force-time parameters quite trivial.

Enhanced Method Results

Figure 7 shows the imbalanced force across the second elbow pair (from Figure 4) including all loads in
the force balance as shown in Equation 2.

Here one sees that at time zero, the force imbalance is zero. Further, after 2 seconds the force imbalance
oscillates and approaches zero and will eventually decay to zero. This is in accordance with the fact that
under steady-state conditions there is no force imbalance at this elbow pair.
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Figure 7. Imbalanced forces at second elbow pair using enhanced method.



Figure 8 compares the results from Figures 6 and 7 in one graph.
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Figure 8. Comparison of imbalanced forces at second elbow pair.

It can clearly be seen that neglecting the valve loading leads to incorrect results. Not only do we see an
error in the magnitude of the loading, we also see an entirely different direction of loading. The reason
for this can be explained using Figure 9 below. By neglecting the load at the valve, the dominant load
and direction occurs when the pressure rise reaches the elbow on the left, creating a net load to the left.
By the illustration in Figure 9 below, that would be the negative X direction. In the CAESAR Il model,
this would be in the positive Z direction. When all loads are included, the load on the upstream side of
the valve is dominant, and acts in the opposite direction. This is demonstrated by the offset of the timing
of the maximum loading in each case. The pressure (and force) at the valve increases at an earlier point
in time than the force at the upstream elbow, because the pressure must travel from the valve to the
elbow.
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Figure 9. Comparison of imbalanced forces at second elbow pair.

Method Maximum (Ibf) | Minimum (Ibf)
Neglecting 13,500 1,300
Valve & other

loads

Including All 9,500 220
Loads

Figure 10. Maximum and minimum ABSOLUTE values of imbalanced force for second elbow,
including and neglecting valve loads.

This underscores the importance of including all loading, and with the uncertainty of the real
loading on components between the elbows using hand-calculations, also demonstrates the
importance of relying on analysis for easily-obtained, realistic results.

For completeness, Figure 11 shows the imbalanced force across the first elbow pair (from Figure 4)
using the enhanced method which includes all forces as shown in Equation 2. The filter in this vertical
line also poses a problematic scenario for hand-calculation methods.

Note that all of the force data generated can be exported to an ASCII file or copied to the Windows
Clipboard and easily manipulated in Excel or other software. The force data generated by AFT Impulse
is not restricted for use with CAESAR Il. Side calculations in Excel or in-house software can be easily
performed with this data.
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Figure 11. Imbalanced forces at first elbow pair using enhanced method.

Exporting AFT Impulse Results to CAESAR I

In CAESAR 11 there are two methods that can be used to dynamically evaluate impulse loading: Time-
History analysis and Spectral analysis. Time-History analysis performs the time-slice integration
required to accurately ‘observe’ the behavior of the system through each step of the transient event.
That is, we can see at any point in time what is happening at each point in the system through the
analysis.

In contrast, Spectral analysis predicts only the maximum response of individual natural frequencies in
the system, and then sums these responses in an SRSS type of fashion. For this reason, Time-History
analysis is the more accurate of the two methods.

In spite of this superior accuracy, the CAESAR |1 utility that imports AFT Impulse force-time data is, up
to version 7.00 (a.k.a. 2014) only designed to setup the CAESAR I input for Spectral analysis. There
are reasons for this, but it may be preferred to use Time-History analysis, which requires a more manual
process than the AFT import utility. We will explain the steps required for both methods.
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AFT Impulse Import / Spectral Analysis Method

After the AFT Impulse simulation is complete, the results can be exported to a file that is formatted for
use by the CAESAR Il AFT Impulse import utility. In Impulse, this is done using the “File” drop-down
menu with the “Export Force File” option (Figure 12), which launches the Export CAESAR Il window
(Figure 13).
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Figure 12. The AFT Impulse File menu has a feature for exporting files for CAESAR II. Note that
this feature is only visible on the File menu when working in the Output, Graph Results or Visual
Report window.
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Figure 13. AFT Impulse’s Export CAESAR Il force file window using enhanced method, which
includes friction and momentum.

Here, users can select which force sets they want to export, the force and time units, and whether to
neglect or include friction and momentum.

A limitation of CAESAR Il through version 5.30 (2011) is that its AFT Import utility can handle a
maximum of 2500 data points, whereas AFT Impulse may generate a force file with more than this.
When more than 2500 are generated, the user will need to adjust the data set exported by setting a user-
specified time frame, and/or by selecting a wider time-step between data points.

Usually, the transient events of interest to the stress analyst are less than a few seconds in duration, so a
30 second Impulse analysis duration can often be quite easily narrowed to a specific time-frame of
interest.

Note that CAESAR I1 expects to receive this data in time-units of seconds using the AFT import
utility, while CAESAR 11 users familiar with the dynamic input are accustomed to entering time
data manually in millisecond units.
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Figure 14. CAESAR Il force files are in ASCII format and can be viewed with Windows Notepad.

There is no transfer of the input piping model data from Impulse to CAESAR II; this must be created
independently, and it is presumed that the CAESAR |1 file is ready for use by the AFT Impulse import
utility in the next steps.

To import the force-time data for Spectral analysis, we access the AFT Impulse utility through CAESAR
I1I’s Tools drop-down menu:

Tools > External Interfaces > AFT Impulse
which will launch the following dialog:
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Figure 15. The dialog will first show up with blanks in most fields. You should use the Browse
button to locate and load the force file. This is a dialog window in CAESAR II.

More than one force-time data set can be stored in one force-time file, which can represent the loading at
several points in the piping system.

In this example, we have selected one force-file that contains two force-time profiles for two elbow
locations being loaded. The selection of force-time data for both legs was done in Impulse. 1f you
export individual force-time data for single legs of pipe in separate force-time files, CAESAR Il will not
let you combine them afterward in this dialog. To combine multiple force-time profiles for multiple
pipe legs, you must export them at the same time into one file in Impulse.

You next click your mouse on each of the force files in order to activate the prompt required to specify
the node numbers in the CAESAR Il model where the loads will be applied. For this model, we are
applying the loads at nodes 1040 and 480.

You may wish to adjust the number of data points that will be used to represent the response curve, and
you may sometimes need to adjust the maximum value on the frequency axis of the response curve.
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Figure 16. AFT Impulse import dialog. This is a dialog window in CAESAR II.

Each of the two force files loaded in this example will be used to create two separate response curves
that CAESAR 11 will use to predict how each natural frequency in the system will respond to each load.

When you finish the selections & click the Ok button, CAESAR 11 warns you that the force data in the
force-time files lack directional information. AFT Impulse does not “speak” in the XYZ terms that are
understood by CAESAR I1; it relies on non-directional lengths and elevations. This means that the user
is required to specify the direction of the loads after CAESAR Il creates the dynamic input.

Warning —=

The current dynamic force fle contains uni-directional data.

If a CAESAR. II dynamic input file is generated with this data, the force wil be assumed

to actin the "Global X" direction. This should be checked for accuracy from the CAESAR 1T
dynamic input module.

You are next asked whether you want CAESAR 11 to create the dynamic input.
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' Dynamic Input File? -

Would you like to create a
Ciynamic Input File MNow?

If you click Yes, you will then need to choose the CAESAR |1 file that will have the dynamic input
added to it. When you next open CAESAR II’s dynamic input, you will see the input created, starting
with the definitions of the response spectrum graphs that were created in the Spectrum Definitions tab.
You may need to scroll down the list to see them, as CAESAR Il does automatically list other built-in
spectra. These additional spectra can be safely deleted from the list to tidy-up the input if you wish, by
highlighting the unwanted lines of data (using the gray column on the left) and the red * - button.

O O O
 analysis Type: Water Hammer/Slug Flow Gpectr » | 2] @ &£ @ @ | |2 o
Spectum Definitions |FDrCB Sets | Spectrum Load Cases | Static/Dynamic Combinations | Lumped Masses | Snubbers | Cantrol Farameters | Advanced ‘
Cmt Name Range Ordinate Range Ordinate
Type Type Interpol Interpol
32 O
[55) O #P1040.0LF FREQ FORCE LiM LiM
34 O #P450.DLFF FREQ FORCE LiM LiM

Figure 17. Spectrum Definitions in CAESAR Il

The data points contained in the graph do not exist within this dynamic input. If they did, you would be

able to view the F-T data using the spectrum data set button. In this case, the data is instead contained in
separate files in the working folder. The octothorpe (#) preceding the name tells the dynamic input to go
find the data in this file in the current working folder.

These spectrum definitions require no editing. There are two response curves defined, both having a
horizontal axis of Frequency, and vertical axis of Force, and both axes are linear in scale (as opposed to
logarithmic). Selecting the next tab to the right, ‘Force Sets’ shows the correct loading and location, but
the direction column requires us to make a selection (X/Y/Z). In Figure 18, the Direction column has
been edited to set the correct direction for each force set. Note that the maximum load has been
extracted from the force-time data and has been placed in the Force input column for each force set
automatically by CAESAR II.
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Figure 18. Force Set Definitions in CAESAR Il

In the next tab, “‘Spectrum Load Cases’, the response curves have been matched to the force sets to
create two load cases. Again, the direction column must be set by the user. This needs to be done for
both load cases, so after editing this in the first load case, you click the arrow that changes the displayed
load case so you can see and change the second load case direction setting.

A A O A RGRAP RGRAP

i analysis Type: Water Hammer/Slug Flow (spectr = (0] @ & @ @ | | o
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Cmt_| Spectrum Factor | Dir. ] Force Set# |
0 O
1 O P1040.0LF 1.0000 B B

Figure 19. Spectrum Load Cases in CAESAR II.

Although it is typical to combine both load cases together, this is not how the input has been created by
the import utility. To combine the load cases, a third load case would be added (top-right button: Add
New Load Case), with two lines of input data that includes both loads together. One of the
shortcomings of Spectral analysis is that there is no sense of timing, so the addition of loads and modal
responses tend to be on the conservative side, unless harmonic load magnification is an issue.

The next input tab is ‘Static/Dynamic Combinations’, where static cases can be combined with dynamic
cases to check combined stresses for code compliance, and to check combined restraint loading.

O RCRAP NCRAP » »
§ dnalysis Type: Water Hammer/Slug Flow Gpectr = (2] @ & @ @ | 2 o
Spactrum Definitions I Force Sets | Spactrum Load Cases ‘ Stafic/Dynamic Combinations ‘ Lumped Masses | Snubbers | Cantrol Parameters IAdvanced ‘
Stress Types: H Add New Load Case
Editing Load Case # Of
|:| Delete Current Load Case
Cmt_| Load Case | Factor |
0 L
1 ] S1WEUS) 1.0000
2 O 01 1.0000

Figure 20. Static/Dynamic Combination Load Cases in CAESAR L.
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The input that was created only combines the load cases required to check occasional stresses, that is,
combining Occasional (dynamic) stresses with Sustained (static weight & pressure) stresses for code
compliance. For restraint load combination cases, the user will have to add these cases manually.

The ‘Lumped Masses’ and “‘Snubbers’ tabs are ignored and left to the user to define if required.

The ‘Control Parameters’ tab typically requires that the Static Load Case be set to check non-linear
restraint status. If unfamiliar with this, the field-level help or documentation in CAESAR 11 should be
consulted. Usually this is set to an Operating case. In this example we have only a Sustained static case.

Another Control Parameter setting that will improve the accuracy of your analysis is changing the
default mass model from Lumped to Consistent. This also comes at a cost of higher RAM requirements.

A A O 0 0O A RGRAP NGCRAP
ER
i analysis Type: Water Harmimer/Slog Flow (spectr = | (5] @ | @ & |
Spectrurn Definitions | Force Sets I Spectrurn Load Cages | Static/Dynamic Combinations | Lumped Masses | Snubhers | Control Parameters | Advanced
Def | Setting [ Parameter
[ | 1W(sUS) Static Load Case for Monlinear Restraint Status
0.0 Stiffness Factor for Friction (0.0-Mot Used)
1] Max. Mo, of Eigenvalues Calculated {0 - Mot Used)

Freguency Cutoff (Hz)
Closely Spaced Mode Criteria
Re-use Last Eigensolution (Freguencies and Mode Shapes)
Spatial or Modal Combination First
Spatial Combination Method (SRI3/ABS)
Iodal Combination Method (Group/10%/DERSSABE/SRES)
Include Missing Mass Cormponents (Y/H)
Mizsing Mass Combination Method (SRIS/ABS)
Directional Combination Method (SRSS/ABS)
| Mass Model (LUMPED/CONSISTENT)
Sturrn Seguence Check on Computed Eigenvalues (/M)

Figure 21. Setting Control Parameters in CAESAR Il

As a summary of the combined load results in this Spectral analysis, the results show:

e Maximum stress = 13,880 psi

e Maximum displacement in the Z direction (along the axis of the valve) = 5.4 inches

e Maxim displacement in the Y direction (along the axis of the vertical run) = 0.14 inches
e Maximum displacement in the X direction = 5.9 inches

The piping model is well restrained in the vertical direction, but mostly unrestrained in the horizontal
plane, which would explain these relative displacements (support friction is not being considered in this
case).

Time-History Analysis Method

The input required for Time-History analysis is almost exactly the same as that for Spectral analysis.
Both require the same force magnitude, direction and location. Both will incorporate the same force-
time data. Static and Dynamic Load Combinations are also input the same way. The fundamental
difference is that, in Time-History analysis the force-time data is applied directly to the model, and the
response is evaluated at incremental steps in time through the event. Spectral analysis instead converts
the force-time data into a maximum-response curve that is matched to the natural frequencies of the
piping system. Unlike Spectral analysis, Time-History considers the timing of events, and considers the
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Kinetic energy of the system in motion during the event. Also, Time-History input is not automatically
created for us, so we have to manually input more of the data to perform this analysis, even if AFT
Impulse is used in the transient hydraulic analysis.

The force time data generated by Impulse for the Spectral method is not in the format required by Time-
History input, and the unit requirements are different also. Time-History requires millisecond units in
the force-time input, while Spectral required seconds when importing AFT Impulse data.

Fortunately, Impulse provides an easy way to export numerical X-Y data of all kinds in a general format
that can be used for Time-History force-time input.

Looking back at Figure 7 & 11 in the Graph Results window and the graph of force imbalance over
time, this graphed data can be copied to the Windows clipboard using the “Copy X-Y Data” button from
the Edit menu and then pasted into another data-handling software such as Microsoft Excel:

Edit

by

=3 | Copy elE
2 Copy X-Y Data

&” | Clear Initial Guesses...

Figure 22. The AFT Impulse Edit menu has a feature for copying numerical data from graphs.
Note this feature is only visible on the File menu when working in the Graph Results window.

20



The AFT Impulse File menu has an option for saving the graph’s numerical data directly to a file:

Eile
J Mew

Cpen... Ctrl+0
| save Ctrl+5
B savess.

Save Graph As...

Save Graph Data As...

Export Force File 4
g | Print Preview... Ctrl+P

Start Batch Run...
Create Adobe PDF...

Impeort GIS Shapefile..,

Figure 23. The AFT Impulse File menu has a feature for saving numerical data from graphs to a
text file. Note that this feature is only visible on the File menu when working in the Graph
Results window.

The recommended procedure from here is to first copy the force-time data from Impulse, then paste it into an
Excel spreadsheet, and then later copy/paste it into the Force-Time input grid in CAESAR II. Before you can
paste into CAESAR II’s dynamic input though, you must first create your force-time graphs in the Spectrum
Definitions tab.

Access the Dynamic Analysis module, and select Time-History Analysis as the analysis method.

Highlight and delete the spectra that are default-loaded in the Time-History Definitions (optional), and click on
the red & white + button to add some blank data lines.

Here we first define the name and axes of the Force-Time graphs.

The name can be anything, but it is wise to use node number in the name. This helps keep track of your data as
the number and locations of loads increases.

Set the graph names and axes to TIME, FORCE, LINEAR, LINEAR for each graph.
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B Dynamic Analysis - [CA\DOCUMENTS AND SETTINGSUIM WILCOXAMY DOCUMENTS\CODECADNNTERGRAPH)
P File Edit Tools

Eﬁnalysis Type: Time History hd | = @ ﬁ | @ | IL I—"_"h éﬂ -

Time History Definitions | Force Sets | Time History Load Cases | Static/Dynamic Combinations | Lumped Masses | Snubbers | Caontrol Parar

Range Ordinate Range

. LLIu Type Type Interpol
1] O TH1040 TIME FORCE LINEAR
1 O TH4ED TIME FORCE LINEAR

Figure 24. Time-History graph definitions in CAESAR II.

Next, use the “scatter-plot-looking” button to launch the dialog that lists your graph names. With the
first graph, select the name and click OK.

0 Select a Spectrum Name

Mo
TH4a0
| (8] | ’ Daone ]

This launches the force-time input dialog:

"Spectrum Name : TH1040

+| 4
‘ Range DLF / Ordinate
{milliseconds) {Ib.)

il
0.8
0.6
0.4
0.2

0

0 01 03 0.5 07 09 1

[ Fead From File... l

| OFK, | l Cancel l

Figure 25. Force-time data input dialog in CAESAR Il
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Ideally, one would then copy the Excel data from Impulse & paste it into this window. Unfortunately, as
of the time of writing this, in order for this dialog to accept the pasting of data, you must first click on
the “ +  button the number of times it takes to create the number of blank rows required. Yes, really.
(And no blank lines are allowed.)

It sounds like a lot of unnecessary work, but does not require a lot of time. In this example, about 800
data rows were created in about 2 minutes. The ability to more easily copy/paste into these fields is on
the development wish-list.

" Spectrum Name : TH1040

+| 4

Range

DLF / Ordinate -
{milliseconds] (Ib.) 3

w| o] - ;o] ;] = W K =] 2

0.0000

5.1500
10.3000
15.5000
20.6000
257612
30.59000
36.1000
41.2000
46.4000

Read Fram File...

0.0004
0.8418
1.6987
21335
286597
3.0056
3.4520
43163
5.1685
B.0786 | -

DK | ‘ Cancel

10000

8000

|

6000

I

4000

2000

|
|
/Y

LA

v

0
0 05 1 15 2 25 3 35 4 45 5

Figure 26. Force-time data [Ctrl]-V pasted into dialog in CAESAR Il
Here are some of the results from the Time-History analysis:

e Maximum stress = 22,930 psi

e Maximum displacement in the Z direction (along the axis of the valve) = -6.24 inches

e Maxim displacement in the Y direction (along the axis of the vertical run) = -.04 inches
e Maximum displacement in the X direction = 5.67 inches

In comparison to the Spectral analysis results, the Y and X displacements are quite similar in magnitude, but with
Time-History analysis, the Z direction displacement is about 15% higher (and the opposite sign), and the stress is
about 65% higher than predicted by Spectral analysis.

Spectral analysis loses its loading signage through the process of SRSS summations; everything gets squared,
added and “square-rooted”, so all negatives disappear.

Spectral analysis will often provide similar, but slightly more conservative results than Time-History analysis, but
when harmonic amplification occurs due to the alignment of natural frequency responses with oscillating loads,
Time-History analysis can predict much higher resulting system response that Spectral analysis is simply
incapable of capturing.

With the advantages of Time-History over Spectral analysis, you are certain to see this as an option in the AFT
Impulse import utility in a future version of CAESAR I, as Intergraph’s development staff have confirmed that
this capability is on their development “wish list’.
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Limitations in Creating Accurate Force Data

Transient force imbalances are sensitive to the difference in pressures at a given time. This means it is
sensitive to the speed of the pressure wave (wavespeed or celerity). When waterhammer pressures drop
to vapor pressure then transient vaporization can occur. It is well known that vapor or gas in a pipe
changes the wavespeed. This is difficult to model using modern methods and hence, force generation
under cavitating conditions is not reliable.

Conclusions

It is important to model waterhammer events for proper system design and operation. AFT Impulse can
generate transient forces that include friction, momentum and in-line component loading which can then
be easily imported into CAESAR Il. The difficulties and uncertainties in manually predicting load
magnitudes, load differentials and the relative timing of these loads makes computer-based transient
analysis a requirement in most cases where transient hydraulic loads must be predicted and understood.

Employing analysis for both the hydraulic transients and mechanical response naturally provides more
accurate results than manual approximations, but an important added benefit is the ability to examine all
possible solutions to a problem. Instead of simply adding more restraint or reinforcement to stop a
system from moving or breaking, sometimes hydraulic system modifications can provide a less
expensive, safer solution.

A zip file of the files used to prepare this paper can be downloaded at:
http://www.codecad.com/AFT-C2-Imperial.zip

Note that, with the Control Parameter settings in the Time-History example used, it may be necessary to increase
the amount of RAM allocated to CAESAR 11 using the Configuration/Setup utility.

Questions or problems related to the application of the software can be addressed by email to:
support@codecad.com or support@aft.com.
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